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Crimea and Sevastopol: Legal Regime 

• Declaration of “Verkhovnaya Rada” dated March 20, 2014 

• Law “On Ensuring Rights and Freedoms of Citizens and Legal Regime in 

Temporarily Occupied Territory of Ukraine” dated April 15, 2014 

 Territory of Ukraine – Ukrainian legislation applies 

 Special regime of entry/exit for individuals and goods (contemplated) 

 No restriction on business activities – subject to the special legal regime to 

be defined in a separate Law (not yet adopted) 

 Non-compliance with Ukrainian law requirements by Ukrainian or foreign 

legal entities and individuals may result in administrative, criminal and civil 

liability 

 Acts/decisions of Crimean authorities established in violation of Ukrainian 

law are invalid ab initio and do not have legal consequences 
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Banking and Currency Control 
 Russia: Federal Constitutional Law No. 6-FKZ – a special transition period – the 

banks may continue operating based on Ukrainian license, subject to filing with the 

Russian Central Bank of a set of required documents 

 Banks that do not follow the above requirements are closed down  

 The Russian Central Bank already prohibited operation in Crimea/Sevastopol 

of more than 18 Ukrainian banks, these banks are allowed to transfer their 

assets to third parties but cannot perform banking operations 

 Hryvna is no longer allowed as a payment instrument starting form June 1, 2014 

 Ukraine: Resolution of National Bank of Ukraine (“NBU”) No. 260 of May 6, 2014 

(came into force on the same day): 

 2 Crimean banks are declared closed and their licenses are canceled (i.e., 

“Chernomorskiy Bank of Development and Reconstruction” and Bank 

“Morskoy”) 

 All Ukrainian banks are completely prohibited from providing any financial 

services and operating in Crimea (Crimean branches, if any, must be closed) 

 Confirmed that general Ukrainian currency control rules apply 

 UAH (Hryvna) is the only valid currency in Crimea/Sevastopol, all settlements 

between Crimea and mainland of Ukraine shall be made in Hryvna 
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Property Rights (Ukraine) 

Law of Ukraine “On Ensuring Rights and Freedoms of Citizens and Legal 

Regime in Temporarily Occupied Territory of Ukraine” 

 

 Acquisition and termination of ownership rights to real estate must 

comply with mandatory requirements of Ukrainian legislation 

  

 Any transaction, which contradicts Ukrainian legislation, will be 

void and will entail no legal consequences 
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Property Rights (Ukraine - continued) 
 Property rights to real estate are subject to registration with the Ukrainian 

State Register of Property Rights to Real Estate 

 Who registers transfer of title to the property located in Crimea? 

 State registrar where one of the parties is located (if outside of 

Crimea) 

 State registrars in Dnipropetrovs’k, Odessa, Khmelnytsky and 

Chernigiv regions if the application is made to the Crimean state 

registrars, and/or 

 State registrars in Kherson and Zaporizhzhya region – upon 

application 

  Order of the Ministry of Justice “On Measures Ensuring Rendering 

  of Services in State Registration of Property Rights to Real Estate” 

  dated March 14, 2014 
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Tax/Customs:  
Supply from mainland Ukraine 

 

 

Supply of goods from mainland 
Ukraine to Crimea 

• Import transaction for Russia:  

• 18% / 10% Russian VAT 

• customs duties 

• non-tariff barriers 

• Domestic transaction for Ukraine:  

• 20% / 7% Ukrainian VAT 

• no customs duties or non-tariff 
barriers 

Supply of goods, on average, 
about 20% more expensive. 
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Tax/Customs: 
Supply to mainland Ukraine 

 

 

Supply of goods from Crimea to 
mainland Ukraine 

• Export transaction for Russia:  

• 0% Russian VAT 

• customs duties 

• non-tariff barriers 

• Domestic transaction for Ukraine:  

• Crimean supplier unlikely to 
charge 20% Ukrainian VAT 

• VAT invoice unlikely to be 
registered 

• no customs duties or non-tariff 
barriers 

Supply of goods likely without 
VAT and, thus, cheaper. 
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Tax & Customs Landscape 

UKRAINE 

General rules remain applicable: 

• reporting and filing 

• payment of taxes and collections 

• customs control of goods imported from Russia 
into Crimea 

Occupation period rules: 

• tax breaks designed for Crimean taxpayers 
registered in Crimea and city of Sevastopol for the 
duration of occupation (being drafted by the 
Ministry of Revenue and Duties of Ukraine) 

• Crimean legal entities and individual 
entrepreneurs may re-register in mainland Ukraine 
and pay taxes at its new address (in force) 

• customs control of individuals at the border with 
Crimea (as per Draft Law No. 4473-1 On Provision 
of Rights and Freedoms of Citizens of Ukraine on 
the Occupied Territories of 19 March 2014) 

 

 

 

 

 

 

Sanctions for non-compliance with general rules 

Tax Code: 

• article 117 – violation of rules on registration  

• article 120 – failure to file tax reporting documents 

• article 126 – violation of rules on payment of taxes 

Administrative Offenses Code: 

• article 163-1 – violation of tax accounting rules  

• article 163-2 – failure to file orders for payment of 
taxes and collections 

• article 163-4 – violation of rules on payment and 
reporting in relation to personal income tax 

• article 164 – business activity without registration 
Criminal Code: 

• article 201 – smuggling 

• article 205 – sham business 

• article 209 – money laundering 

• article 212 – tax evasion 

• article 212-1 – social security contributions evasion  

• article 358 – forgery 
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Tax & Customs Landscape 

RUSSIA 

Transition period rules: 
• taxes, customs and other duties, any other 
collections to be paid in RUB  

•until 1 January 2015, tax and other revenues to be 
paid to budget of Crimea, city of Sevastopol and other 
local budgets 

• since 1 March 2014, input VAT from Ukrainian 
taxpayers could not be offset against output VAT but 
is treated as deductible expense for CIT purposes 

• VAT debts for tax periods before 1 March 2014 were 
written off 

• VAT invoices issued since 18 March 2014 not to be 
registered 

• starting from 26 March 2014, 18% / 10% VAT applies 
to goods supplied to Crimea from mainland Ukraine 

• right to recover input VAT incurred on goods supplied 
from mainland Ukraine 

 

 

 

 

 

 

Issues: 
• applicability of Ukraine-Russia double 
tax treaty / domestic rules on taxation of 
non-residents’ income: 

• risk of double taxation, permanent 
establishment risk 

• loss of foreign tax credit and other 
treaty benefits 

• applicability of the CIS Free Trade 
Agreement / WTO instruments 

• replacement of tax identification codes 
issued in Ukraine 

• registration of branches of Russian / 
Ukrainian legal entities in Crimea and 
city of Sevastopol 
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Jurisdiction of Ukrainian Courts 
Law of Ukraine “On Ensuring Rights and Freedoms of Citizens and Legal Regime on Temporarily 

Occupied Territory of Ukraine” of 15 April 2014: 

disputes pending at Ukrainian courts in Crimea and all future claims (to be considered by such courts) 

shall be considered by the following courts:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Administrative and Commercial Cases 

Administrative/Commercial  

Courts of the Autonomous  

Republic of Crimea  

Administrative/Commercial  

Courts of the Kyiv Region 

Administrative/Commercial  

Courts of the Sevastopol City 

Administrative/Commercial  

Courts of Kyiv City 

Civil and Criminal Cases 

Local courts of the Autonomous  

Republic of Crimea/Sevastopol City 

          Local courts of Kyiv City  

       (shall be determined by the  

        Appellate Court of Kyiv City) 

Appellate courts of the Autonomous  

Republic of Crimea/Sevastopol City 

Appellate Court  

of Kyiv City 
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Russian Law Perspective 
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Russian legislation on Crimea 

‒ Russo – Crimean Treaty on Accession of Crimea to the Russian 

Federation, March 18, 2014 

‒ Federal Constitutional Law No. 6-FKZ On Acceptance of Crimea to the 

Russian Federation and Formation of Two New Subjects of the 

Federation – Republic of Crimea and City of Sevastopol, March 21, 2014 

‒ Federal Law No. 37-FZ On Functioning of the Financial System of the 

Republic of Crimea and the City of Sevastopol During the Transition 

Period, April 2, 2014 

‒ Federal Law No. 39-FZ On Protection of Interests of Individuals Having 

Deposits with Banks Registered and/or Operating in the Republic of 

Crimea and the City of Sevastopol, April 2, 2014 

‒ Normative acts of the Russian President, Russian Government, Central 

Bank of Russia, Federal Tax Service, Federal Customs Service, 

competent authorities of the Republic of Crimea and the City of 

Sevastopol 
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Crimea - Russian legal regime (1) 
‒ Citizenship – Automatic Russian citizenship for all residents, unless formally 

refuse by April 18, 2014. Russian passports already issued 

‒ Transition period – until January 1, 2015 

‒ Local governance – new governing bodies to be created in Crimea and 

Sevastopol by way of elections scheduled for September 13, 2015. Until than, 

present bodies govern, and can adopt local legislation, subject only to 

compliance with the Russian Constitution 

‒ Local entities – may continue operating in their current legal form until 

January 1, 2015, but they must re-register as Russian legal entities or 

branches / rep. offices of foreign companies, otherwise, they would be unable 

to perform any business activities after that date  

 Local subdivisions of the Russian Federal Tax Service are already actively 

registering legal entities, entrepreneurs willing to legalize under Russian rules. Until 

January 1, 2015 such registration is exempt from state duty 

‒ State permits and activity licenses – documents issued by the time of the 

Crimea accession to Russia remain valid without limitation, unless otherwise 

flows from the said documents or the corresponding legal relations 

 Exception: banks, financial organizations, customs brokers 
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Crimea – Russian legal regime (2) 
‒ Non-banking financial institutions (security market operators) that 

perform depository activities in Crimea - may continue operating without a 

license until January 1, 2015 

‒ Currency – the only legal tender is Russian Ruble starting form June 1, 

2014 (Ukrainian Hryvna is no longer allowed for payments) 

‒ Cash-control equipment – special transition rules apply until January 1, 

2016 as approved by the local government of Crimea on June 4, 2014 

‒ Administrative, family and other state documents – all such 

documents duly issued by competent Ukrainian authorities by the time of 

the Crimea accession to Russia remain valid without limitation, unless 

otherwise flows from the said documents or the corresponding legal 

relations. However, as of the time of the accession and until the end of 

the Transition Period any such documents should be obtained in line with 

the Crimea/Sevastopol local legislation. Potentially, this period may last 

until September 2015. Thereafter, general norms of Russian law would 

apply 
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Crimea – Russian legal regime (3) 

‒ Immovable property – the Russian Rosregister already established a 

republican subdivision in the city of Simferopol (Crimea) which will re-register 

all the residential and commercial real estate under Russian rules within the 

transition period of 2-3 years. The re-registration is planned to be on a 

voluntary basis, however, after the expiration of the transition period in 

absence of a Russian property document no deal with any real estate without 

Russian documents will be possible  

 Russian State Duma already issued draft law (No. 497399-6) on the 1-

year transition period and simplified rules for re-registration of immovable 

property in Crimea, however, the draft is still under consideration (as of 

July 7, 1024 the draft law has not passed the 1st reading in the State 

Duma)  

 Note! Russian law doesn’t allow foreign citizens and entities owning land 

in sea ports, agricultural land and land in “border territories” (list defined 

by the President’s Decrees)   
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Crimea – Russian legal regime (4) 
‒ Tax – Russian tax laws govern, but during Transition Period taxes are payable to 

the Crimea/Sevastopol budget, and their establishment, incentives and 

enforcement are governed by local normative acts 

‒ Russian tax laws already apply in Crimea (except for land tax and state duty) with 

respect to local Russian legal entities and their branches/rep. offices that were 

registered with the Unified State Registrar of Legal Entities (EGRUL), as well as 

separate subdivisions of foreign companies established in Crimea after March 18, 

2014 

‒ Customs – Russian/Customs Union rules to apply over the Transition Period. 

However, during that time no passport of transaction is required. Customs Houses 

of Simferopol and Sevastopol and 3 customs posts on the border with mainland 

Ukraine were established, customs control on the ferry line between Kertch 

(Crimea) and Port Caucasus (Russia) is suspended. Cargo transportation between 

Crimea and mainland Ukraine is presently allowed based on shipment documents, 

without customs clearance   

‒ Labor –Russian citizens may freely work in Crimea and Sevastopol. Other 

citizens, including Ukrainian, have to obtain Russian work permit/visa. But the 

issuance of work permits/visas will start only in 2015. Ukrainian nationals currently 

work under migration cards, which is formally illegal but informally allowed during 

the transition period (yet no fines or other administrative sanctions imposed) 
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Crimea – Russian legal regime (5) 
‒ Judicial system – local courts to be formed in Crimea/Sevastopol under 

Russian law by the end of Transition Period. Until than, existing courts 

continue performing their activity  

 Russian Federal Law No. 154-FZ dated June 23,2014 established the judicial 

system of Crimea, the Russian Supreme Court is to set the date when the 

courts should start functioning and establish a law enforcement mechanism 

for court decisions taken in Crimea   

‒ Civil law and administrative cases fully considered (including cassation) 

by the time of the Crimea accession to Russia are not subject to review 

‒ Civil law and administrative cases not fully considered (appeal and/or 

cassation still being pending) can be so considered under Russian 

material and procedural law 

‒ Criminal investigations and cases in progress are finalized under Russian 

material and procedural law, subject to review and confirmation of the 

charges by the competent prosecutor in Crimea/Sevastopol 

‒ Criminal investigations, cases and sentence for the crimes non-existent 

under Russian law shall be suspended 
18 



© 2014 Baker & McKenzie – CIS, Limited 

INSTRUCTIONS 
How to apply a Slide Layout 

Go to the Home tab and select   

New Slide to choose from a  

variety of formatted B&M slide layouts 

Tip: choose Layout to reapply a layout to a 

selected slide(s) 

How to apply slide text styles 

Use the Decrease List Level and Increase 

List Level icons on the Home tab to apply 

the required text style 

Tip: use the Reset option from  

the Home tab to restore template text styles 

to a slide 

How to update footer and slide numbers 

Go to the Insert tab and select 

Header & Footer. Select Apply to 

All once update has been made 

Doing Business in Crimea –  

Practical issues from the Russian side 
‒ No coordination with Ukrainian rules 

‒ High risk of challenge by Ukraine for violation of its established procedure  

‒ High risk for products originating from Crimea to be banned for exportation to other 

jurisdictions, the EU already banned Crimean products (such products can be imported 

to the EU only on the basis of a Ukrainian certificate of origin or under an agreement 

executed before implementation of this trade ban) 

‒ Financial system – Ukrainian banks quit, Russian banks come in slowly 

‒ Tax – transition to Russian tax rates and payment procedure yet to be developed, 

chances to credit/refund the taxes overpaid before accession unclear. For Crimean 

business – clear risk of double taxation (unless Ukrainian legislation on special tax 

regime for Crimea is adopted) 

‒ Customs – so far, no clearance in trade with mainland Ukraine, but attempt to enforce 

general Russian customs rules might complicate that trade 

‒ Citizenship – unclear status of those who miss the tight deadlines for refusal from 

Russian passport, unclear labor and migration rules for Ukrainian residents in Crimea 

‒ Contracts – does failure to duly perform constitute force majeure? Problems with 

execution and enforcement for persons inside and outside Crimea 

‒ Real estate – will limitations for foreign ownership of land apply in Crimea? 

‒ And many, many more  19 
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